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1. Hardware Hardware requirements
and §°ftware « Personal Computer with Pentium processor >400 MHz
requirements
+ 256 MB RAM
« SVGA graphics card with resolution 800x600
+ CD-ROM unit
» Mouse

Please note: The TiSecurity-
Polyx program is the essential
tool for the configuration of

the 3485 Burglar alarm Unit. Software requirements

The content of this program - Windows 2000, XP or Vista; Internet Explorer 6.0 or higher.
is under the exclusive rights
of Bticino SpA.
Space used on hard-disk
+ 91 Mbyte.
2. Installation Follow this procedure to install the TiSecurityPolyx program:

1. Insert the CD-ROM in the drive;
2. After displaying the main page in the web format, select “Install TiSecurityPolyx”;

3. The installation program will now copy the system files necessary for the execution of the

TiSecurityPolyx program.
Select Language [E
Fiease select the language that vou would ke to use dunng the
inatallabon.

|takaro

Francaiz
Dewtsch
E spaficl

coe

> Select the installation kit language
> Click the Ok button
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The following screen will appear

3 TiSecurityPolyx 1.0 3

Vi

Welcome to TiSecurtyPoly= 1.0 Setup programe Thas program wall
mistal TiSecuntyP ol 1.0 on wour computer,

It iz strongly recommended that vou exat all \Wirdows programs:
before unning thes S etup Program,

Click Carcel to quit Setup and close ary programs pou hawve
wnning. Click Nexst to continue with the Setup program

WARHNING: Thiz program iz protected by copenght Law and
mternational treabies.

Unauthonzed reproduction o destiibution of this program, or anp
paddion of &, may 1esull n severe civil and criminal penalbes, and
will be prozecuted bo the masimiam exdent possble undss law

Hew> [ Cencel

> Click the Next button

The following screen will appear

2 TiSecurityPolyx 1.0 3

Destination Location

Setup wil install TiSecunbPoly: 1.00in the foliowng folder,
To install into & differert folder, chck Browse, and select ancther folder.

“rou can choose not to rstal TiSecutuPolyx 1.0 by clicking Cancel to exit Setup.

Destnation Folder
C:\Programmire Ticeoh T isecuntyFolys_ 0700 Erowse...

ize Installation Wizard®
Hewt> 1 Cancel

> Click Next to install the program in the default directory
“C:\Programmi\BTicino\TiSecurityPolyx_0100"

Or

> Click Browse to select the required path
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The following screen will appear

2 Language
Application Language
Select the language for the apphcation :

" Itakan
™ French
(" Dutch
" German
¢ Spanish
© Engeh
(™~ Portuguese

ize Installation Wizard®

¢ Back Mead > Cancel

> Select the TiSecurityPolyx interface language (The language can also be changed when using
the application, without the need for reinstallation).

> Click the Next button

The following screen will appear

2 TiSecurityPolyx 1.0

Stant Installation

You are now ready to install TiSecurityPoke: 1.0,

Fress the Mext buttan to begin the inztaliation of the Back button 1o reenter the nstallation
nformation.

ize Installation Wizard®

Cancel

> Click Next if you are ready to install TiSecurityPolyx
Or

> Click Back to return to the previous screen
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The installation of the program will now begin.

TiSecurityPolyx 1.0

Instalhing

2 &

Copying Visual B azic Runtime
CAWINDDWS apstem3ZMSCOMCTL DT

Cumert File

ENEREEENNEREENEEEEE AN
Al Files
Time Remanang 0 mewtes 2 sacond:

wice Installation Wiz d®
| Cancel

Depending on the operating system setup in use, it may be necessary to restart the system.

X

22 TiSecurityPolyx 1.0

TiSecLntyPolyx 1 0 has been successfuly mestalled

Press the Finish button to et this installation

> Click Finish to end the process
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3. Basic concepts The TiSecurityPolyx software is used for the configuration of the 3485 Burglar alarm Unit which com-
bine the burglar alarm and telephone dialling device into one device.
After opening the program, the following screen will appear:

E TiSecurityPolyx - Burghar Alarm Switchb, Configurator
Fie Edt Took Language 7

O v GF opan Bl swe [Brwwwws| Qhrmsnes [ covecten  pen covs = o - hhicing .

o Mytomes cantral unit
W
= g Burghsr slarm
- H Zora () ety Homse burglar alsrm cwitchb,
B comman chiacts @)
B Conrectors ()
B Zore 1 - Zorw 1 (D)
B zore 2 - Zore 2 [

Please note: For proper BB zoe 3-2ow 3 )

functioning of the software, B Zone 4 - Zone 4 @)

the 3485 Burglar Alarm Unit B 7ore 5 - 2ore 5 0

must be installed according B Fore 6 - Zona 6 [@0)

to the indications specified B 7one 7 - Tane 7 (0}

in the installation manual B Zona & - Zone & @)
BB Aumikary (0)

supplied with the device. & automations (0)
" 4

£ User preferances
= 3B putaller preferences
=3 ey Managament (0}
) Scenarios ()
= &% Dialling davica
&) Talephone rurmber dirsctory
% Sat calls ([0)
Iﬂ Talephone Furctions
T Blodk {0)
P Protocol
[ Line test

ﬁ Takephors conlrak (0} p—

1502005 1535 Lind 3456

Depending on the technician and user’s needs, it is possible to begin with a new configuration or
change an existing configuration.
In this manual the various screens will refer to the second mode.

Creating a new configuration:
e Start TiSecurityPolyx
* Execute and save the configuration
* Send data to the Unit

Modifying an existing configuration:
* Execute the system auto-learning function from the Unit
* Receive data from the Unit with TiSecurityPolyx
* Edit, if required
* Send data to the Unit

In order to perform a proper configuration, it is necessary to execute the system auto-learning
function before connecting the Unit to the PC.

Using the Firmware Update function, with the TiSecurityPolyx it is also possible to update the per-
manent Control Unit Software, using new issues published by BTicino.



3.1 Menus and general buttons for selecting functions

L9

The main functions that can be executed with TiSecurityPolyx can be selected by using the icons
in the toolbar or by opening drop-down menus, thus selecting the various options. Quick keys can
also be used for some functions, like:

to create a new project, itis possible to select New from the File drop-down menu, from the toolbar
and from the keyboard by using the keys Ctrl +N.

The followings functions are included in the toolbar:

Select the interface
language

Save the current
project

Create a new Opens the Para- Executes connection to Executes connection to
project meters section the Unit the Bticino website

| e 5 ooen il save [ Pt 4 msonoee | [ conmectin &

Pt COM2 = pmglerguage = ht“:lm -

Opens an existing
project

Opens the Voice
message section

Selects the serial port of
the PC to which the Unit is
connected

The followings functions are included in the drop-down menus:

“File” menu
A TiSecurityPolyx - Burglar Alarm Swii
Fle | Edt Todk Languge 7 * New creates a new project
O roew i+t [pasmesd  © Open opens an existing project
= Dipeh a0 .
#  *Save saves the current project
| = T oS

Sawe with name . .,
Expeort confgr sbon i)

Exit
TET DT IO LT

[SecurityPelyc - Durglar Alarm Seiichl, Confige
Lk | Took Renguepe T
Yrport metages From profect nge
Imort canfagur sbon: data from projec
L pre-flefired sk mestages
Gt gl g =
it 3l Framed g )

* Save as (with name)

* Export configuration

* Exit

“Edit” menu

° Import messages from project
* Import configuration data from project

* Load pre-defined audio messages
* Select all messages

* Select all fixed messages

saves the project after requesting a file name

exports the project thus creating a file with
extension .csv which can be imported into

Microsoft Excel®.

exits the program

imports all voice messages from an existing

project

imports all configuration data from an existing

project

retrieves voice messages set up for the Unit

selects all messages of the project

selects all fixed messages of the project
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rityPalyx - Burglar Alarm Switchb, Conl
| Tocks | Language 7

i Par amehers ] tqijug
i) pasaages g

|

|
BB upcate Frmaee Fr

B Connectionwithut P8

[y Elurlz_lqr Alarm Switchb, innl'igurql!w

PyHonae ke

ar Alarm Switchb, Configurator

“Tools” menu
* Parameters
* Messages

* Receive configuration
* Send configuration

* Update Firmware

* Connection to Unit

“Language” menu

[

uyn

menu
* About...

* Supported versions

opens the Parameters section
opens the Messages section

receives the configuration from the Unit, it is active only
when connecting to the Unit

sends the configuration to the Unit, it is active only when
connecting to the Unit

starts the Unit firmware update procedure

enables connection between the PC and the Unit

select the TiSecurityPolyx interface language

displays information on the TiSecurityPolyx program

displays information on TiSecurityPolyx, hardware and
software versions of the Unit

The status bar shows the following information:

Current data

I ARI0E 0246 Conirale 3485

Loaded project file

Current time
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4. Importing data Itis possible to import data (configuration parameters and voice messages) from a previously saved
from an existing project file.
project

4.1 Importing voice messages

To import voice messages from a project file:

> Select Import messages from project from the Edit menu

Il; TiSecurityPolyx - Burglar Alarm Switchb, Configurator

D) 1 st messsges rom rce. looges | [ Cometon o cowz = ERewee - ybyamn -

Sefect of rassages Colwd burglar alarm swit chi,

The following screen will appear

Inparl measages rom Project

Look i [ L5 Promcts ] ~mem

-3 E
T Progetind. 8
Eg‘m = Pregetiad. s

€,

Dt

)

My Eizcumanis

[ 1
- Carael

¥

a

i

i

E

£
laf s

Please note:itis recommend . .. .
to save the current configu- > Select the project file (. jai) from where you want to import the messages

ration file of before starting > Click the Open button
the procedure.

Fis Edt Took Langusges 7
O vew @ open [l swe B arameters [0 desiages| [ cecomecten | v @ - Bhizing .

o Sond plsten *{Becmm | ¥ leportwae B Laton @ Record
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Please note:itis recommend
to save the current configu-
ration file of before starting
the procedure.

4.2 Importing configuration data

To import a previously saved configuration:

> Select Import configuration data from project from the Edit menu

I'; TisecurityPolyx - Burglar Alarm Switchb, Configurator

F‘I!;EII Tock Language 7
Dﬁ Import messagas From orojedt .

| Inport conbouation detafrompeoiect |
M Load pre-defined sudha messages poen b7 Sered ] Bvert eveereory
'.; Sadect al Eeasages Chibed busrghnr alsrrn switch,
[ TY 1 p— Fa

B connectors (1)

B 2one 1 - rona 11
Ezone2-zona  2(2
B P T - e a0

The following screen will appear

Lok i [ Promets ] -
= ogeo e
.,...5 T Progetiod.
My Fepant = Frogetiod. ja
Doumenis |

Crprhioge

f
E

A e ]
=]  Cowel

Pl oty Fie i [

> Select the project file (. jai) from where you want to import the configuration
> Click the Open button

When the procedure has been completed, the new configuration will appear

] IBecurityPalyx - Hurglar Alarm Swilchh. Configurator

me=r - hhcina .

Fie Edt Tools Language 7

[} vew G Coen [ Sove [ Faameters| < Messages [ Dteconnection |

BaLagage = »
B MyHome central unit P i R i e
- HP.l.rql.ralxm
- Bzone (12) -
H common obijects [2)
Emlmﬂ]

B zone 1 - zona 1y
Hzone2-ona  2(1
B 2ome 3 - aona 33
EHzoned-zona 4 (3

[ PR, =
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5. Connecting to the To access some functions (e.g. Receive configuration, Send messages, etc.) there must be a con-
Unit nection between the PC where TiSecurityPolyx is installed and the Unit, following the operation
described below.

> From the Port menu, select the serial port address of the PC you want to connect the Unit to
(COMT, COM2, etc.).

> Select Connection to Unit from the Tools menu

& 15ecurityPol Burglar Alarm Switchb, Configurator
yx B 8
Fis Ede .lﬂﬂﬁq Langusgs T

) Mew G ER Paramtons F3 |q@mm [E Cornedton Pot COMS = | PpLonpmge - "
Fi z

Ul MyHome burglar alarm switchi.

o Taocornect the unit, exeoute the folowing cperations:
\._"‘J 1 - B SURE THAT THE UNIT HAS ACQUERED THE BURGLAR ALARM SYSTEM CONTIGURATION BY MEANS OF THE

3 - Connact thpm:rmmcubh ta the dervica
4 = Push 0K to conbirus

o] coes |

> Execute the required operations and then click OK

Select the maintenance menu
of the Unit and start the auto- Slide switch
learning function

MAINTENANCE

Language

Key program

System test B 0
Learning ﬂ P e

Flip the slide switch to off

Click the OK button

o ] cwes

Connect the programming cable to a
serial port or USB of the PC and to the
6-way connector of the Unit

REN

1l
FEE® oz

B -
o] @]

|:| oz I%gl Item 3559
ﬂ =l

Item 335919

I
= |

]
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wait, ..

Bk reading 6532

At this stage, by clicking the Details button, it is possible to display the list of communication acti-
vities between the personal computer and the unit.

LB 2008 15:28: 32 Eal
Corvmmitiny Fupem Eoventy fonsrod bestwssssn L cusren] proct oonfgurslon and thote saved n U contnol ued

Contruse svpway?

1Bf03 2000 15: 2835
Cparabion canceled by the user

T IROTO08 15:10: 8

L} End correction vt the deves
IGO0 152838

3 Cose commmurication port

10402000 152098
&) Cpencommurication pert

L L
) Start connesction wth the denice

When connecting to the Unit, a comparison will be made between the configuration of the Unit
which reflects the real system, and the configuration of the current project.

If the configurations are different, the following warning message it will appear:

i ] Discrepancies of corraspondence betwesn the project dats and those saved in the device hanve been Found. Do you

wark to soe the detal?

[l e

> Click YES to display the details of the differences found

Zorm Devce Pammeim Fropct vk vz waboe Mt
Comimon cbcti fnbamal smen 1 Presence ol penpheisl plerend ol paesond
Conrmcion Faiphwesl 1 Tipm [ e Trazjsrndnn poade
Corwesiois Feighaia £ Pigierce o pargheial Enorund mol paeaend
Cerwme g Feigdwenl Tips Ehiwnziish Mt
T 1 Peigphwial 1 Tipe o] kel ace 1A seazo
S 2 Peiiphers 1 Tipe Cantaci interlace 1N semzo
Zione 2 Peiphesd 2 Presence ol penphens miod peEsed e sk
Zore 3 Peiphessl 2 Presence ol perphes presend ol paenend
Zone 3 Parphedsl 2 Typs N senmw Maone
o 3 Faighessl 3 Piatence ol penphadsl plosond mil presond
Zorm 3 Peuphees 3 Tiee IR cenzor Murne
corm 4 FPoighwal & Tipe Hatho Hecrive Erppad willy chaplay
o 4 Peighwrsl 3 Fiezre o geergbe pisdand mal pessnd
Zone 4 Peiphesa 3 Tipe IR zenso Huoae
Export . . Ot

The data can be exported into a file with extension .csv, which can be imported in Microsoft

Excel.
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> The following message will appear if click QUIT

09 Diferences have bean detected between the system configuration of current prodect and those memorised in the
unhit

I 'u:-advl-;d:\lalul.udataﬂuprmut b e syt condiquration pressnt in the unt,
Do ol wart to koad the system configuration peesent in the wnit in the ourrent project

=1~ |

> Click YES to load the configuration of the system in the Unit

> Click NO to keep the current project unchanged

However, there will be a connection to the Unit.

At the end of the procedure the Connection button will change into Disconnection.

I TisecurityPolyx - Burglar Alarm Switchb, Configurator
Fis Edt Took Langusgs 7

D tew & Cpers [ Sove [0 Parametors| o eszages [l Dlscomrectin | L opmge - >
= MyHome contral unit e Reeve 7 Serad [ Evert swemery
= Burgl alarm -

" Bzone (12) ol o o s ket
I common ohjects (2)
B connectors (2)
B 2ome 1 - zona 1{1
H 2one 2 - zona 201
B zone 3 - zona a3
BEoomed-oona  4(3

It is now possible to swap data with the Unit
Click Disconnection to stop connection.

The following message will appear

1 - Disconnect cable From unit

i j To disconnect the unit, execute the Following operations:
2 - Push OK

e

> Disconnect the programming cable from the Unit
> Click the OK button

6. Exchanging data When the connection to the Unit has been activated, it will be possible to:
with the Unit

. Send/receive configuration parameters
. Send/receive voice messages

o Receive the history of events from the unit

Refer to paragraphs “7.2 Exchanging configuration parameters with the Unit”and “8.2 Exchanging
voice messages with the Unit” to carry out these functions.
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7. Parameters

In this section it is possible to execute the Unit parameters configurations.

7.1

Work area

ﬁ TisecurityPolyx - Burghar Alarm Switchb, Configurator

e Ede
O e G cpan [ Sovn |5 Paewnanern | ) Manaag

Took Language 7

lalle

ts MyHome cenfral unit
".' Ewrghar alarm

@
4]
= 49
#)
= & Dia
-

S
.=

T

fone [17)

B common ohjiscts (2)
[ connectors (2)
E Jomwiz 1 - Dond
B Zone 2 - zona
B Zomws 3 - zona
B 200w 4 - zona
B zore 5 - 2ena
B zore 6 - 2ona

B zore 7 - 2oma
B Zore 8 - zora
E Avnikary (0
Automations [5)
Lser preferances
Fstalier profioronces
=3 Key Management [3)
Soenarios (16)

lling davica

Tedephone muamber direcbory
Set calls (2)

Takephors Furclions

T Block (0)

P Pratcel

Bune wst

Telephone contrats (0}

1(1)
2(1)
3(3)
4(3)
5@
& @)
7
8 o

FhyHoame burglar alsrm switchb.

*yHome burglar slarm switchb.

e covs = Eess - BhcIng -

In this section all typical parameters for the configuration of the Unit are displayed, represented
hierarchically with a tree structure on the left side.
On the right side, a specific template for inputting data and, if the connection is active, for commu-
nicating with the Unit can be displayed by selecting each element of the hierarchic structure.

ﬁ TiSecurityPolyx - Burghar Alarm Switchb, Configurator

Fle Edt

O ew G Cpan [l seem [ 1| Q) Mareag

Tocks Langusge 7

|l =

B Mytome central unit

-"-'Eurqh'al.:l'm

- [F zone (12)
B common ohjects (2)
mmﬁ
[ Zomws 1 -zona 1 (1)
B zone 2 - zona 2(1)
B o0 3 - zona 3(3)
B 2one 4 - zona 4(3)
Eores-xra 5@
BHiores-2ona &@)
Eoe7-20a 70
Bired-zona 8@
B Auilary ()

@ Automations (5)

€] Lser preferences

=48 wwtaller preferences
=3 Koy Management (2)
#) Scenarios (16)

= 2 Dialling device
&) Telephone number directory

s

set calls (2)

= (@ Talephons Furctions

Tz Block (0)
P& Protcol
B Line teat

T Tolephons cortrals (1)

o

+

B2 oevice 1 - pertfesica 1
Présant

Retive

Deserigiion

Tyt

Verson

. Device 2 - pesifericn 7
Present

At

Die sorigiion

Type

Wi Sy

Device 1 = petilerica 1

me covs = ERues - BlcIng -

1( s

o Es
periferica |
.L.-H'l'ﬁ-'lfl'

106

o Wes
& e
pariferica 2

[sK 1
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Data input template

Send configuration to the Displays information
Unit
. . Receives the hist f Communication bar with
Receives configuration eceives the history o the Unit
from the Unit events from the Unit

= . Device | - periferica 1

Present o Vs
Acthva o Yes
Fixed zone Description perifarica | Data input
— . ireperes zone
WErsicd 10,8
+ . Deswice ¥ - periferica 2
+ L}
+  ——
4+ -
A —
+ -
o -
4 —
Help zone Present

Define the presence of devicoe

The upper bar includes the commands for communication with the control unit (only active when
the connection with established PC); the central section is for data entry, and will vary depending
of the selected parameter; the lower bar displays the instructions to guide the user through the
data entry procedure.

7.1.1 Data input procedure

Inputting by typing in data:

> Click the data input zone
> The text, if any, will be edited (e.g. Input)
> Typein new data

Inputting data with the drop-down menu:

> Click the data input zone; the % button will appear

**.-'hm: =

i | > Select any data available
= | ]
bzl B rswae
= [
o . High Freaumncy sedo reoee
= B v ey
-
-

> A drop-down menu will appear after clicking the button

B oot it
B s g
[ e tut st
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Inputting data with the sliding menu:

> Click the data input zone; the : button will appear

> Use the button to move through the available data

Inputting with an independent window:
> Click the data input zone; the E] button will appear

> Anindependent window will appear after clicking the button

l._l;!"»llf!:] |nwm| Soerurns | Tamperaine corrol | Burglar atarm | Ausdiry | Manua |
Tyess of Dt ]
I, =
cnard ——— =
oM > ot 11 =
e Concel | [ cariem |

> Enter the data

> Click OK to close the window
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7.2 Exchanging configuration parameters with the Unit

7.2.1 Receiving configuration parameters

This function allows you to receive the configuration parameters from the Unit.

> Execute the Connection to Unit procedure

> Click Receive button

= IBecurityPolyx - Burglar Alarm Switchb, Configurator
Fis Edt fock Language 7

) bew 3 Open [ Save ﬂslhh::-anul Etllsm'nucbm | ELW' hhnlm_
EI B Burglar alarm
- [ 2one (@) Mytiome burglar alsrm switchi,

B common ahjects (1)

B connectors (1)

H zone 1 - zona 1(1)

Ezone2-rxoma  2(2)

B 2omwe 3 - sona A1)

Ezoned-zoma  4(2)

] Rocove #1 Serd [[5] Evert memery

The following screen will appear

“'?{J e YT LR 0L WanE o reoehes conlfigueation from the unt 7

> Click the Yes button

If the current project has not been saved, a reminder appears on the screen.

\ ?j Current project has besr modfied, Swve &7

e

> Click the Yes button

ﬁ Walt . . .
1

Block raading 16704 Detals |

When the procedure has been completed, the Unit configuration parameters will be available in
the relative section for future verifications or changes.

To activate a new configuration the sending procedure, described in the following paragraph, must
be completed.
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7.2.2 Sending configuration parameters

This function allows you to send the configuration parameters to the Unit.
> Execute the Connection to Unit procedure
> Click Send button

I TiSecurityPolyx - Burglar Alarm Switchb, Configurator
Fis Edt Tooks Langusgs 7

@ - hhicing .

B ML:TI:;:M ] Beceve ] Serd [ Evert moeemcry
- B 2one (2) = Mytome burglar alsrm switchb.

B common ohjects (1)

Hardhaars Terion I
B connectors (1)
Fzome1-oma  1(1) Piremensa Viarsko .
B 2one 2 - zona 2(2) Firtinasin ELpian e 15

B #ranm 1 - Fona A

The following screen will appear

T ) s yous sure you wank by send configurstion bo the ik

> Click the Yes button

If the current project has not been saved, a reminder appears on the screen.

?j Current project has besr modfied, Swe &7

e

> Click the Yes button

When sending the parameters, a comparison will be made between the configuration of the Unit
and the configuration of the current project, if these are different the following warning message
will appear:

i Descrepancies of comespondence bety It predect dats b those saosd in the device have been found, D you

war ko e the cebad®

Vs | w |




Click Yes to display all differences found.

Zarm Dervicn Pasrmier Fropecd vahs Digrvnc vaus | Mobes
(Coammon obpects Irbstrial swen 1 Pravence of pesphersl present nol provend
Corwwciing Preapiwral 1 L) Camevrm:tor Teasprrnlen smadem
Corrmciods Pogheal 2 Peeieracs of poagfeial prozenl ol priepond
I eararees brat Fagidwinl 7 Tyt Dlawizain Meshie
Zore 1 Peaplwia 1 Type Cunlact imeilace IA zenso
Zone 2 Praphersl 1 Type Conlact imedface IN sensor
Zone 2 Peapherd 2 Peeverce of pesphers el presenl pleaem
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When No is clicked (or Quit in the error window), the following message apperas:

Force: dovanload configuabon on the uml
Cancel aboels the dowrlosd operstion without

[ Force_ sige |

Diflerancas hawe been found batwesn The system configuration of the cumant project and that
maserizad i fhe und
Eml?ammdmwmm.mwm thowdd ol waork

ol

Align sliges the peoject corfigueation with that of the Lt withou! downlaadn angdhing
shgnng

Cancel

> Clickthe Force button to send the parameters of the current project to the Unit and then modify

its configuration.

> Click the Align button to change the parameters of the current project, thereby aligning them

with the configuration of the Unit.
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7.2.3 Receiving the history of events

This function allows you to receive the history of events. This is the chronological list of all events
occurred on the burglar alarm system, and recorded by the Unit.

> Execute the Connection to Unit procedure

> Click Event memory button

I TisecurityPalyx - Burglar Alarm Switchb, Configurator

Fis Edt fook Langusgs 7

D tew @ cpen [l save [ Parametors] Q) wessages [l Disconmecton B Lo - »
B MyHome central unit &7 Recemn 0 Sered [ Evert .
= ' Burglar alarm

- B 2one (12) *ytome burglar alsrm switchi.
B common ohjects (2)
B connectors (2)
B 2ome 1 - sonia 1{1)
B oone 2 -zona 2(1)
B Zrawm 7 - Frva A

The following screen will appear

,‘:..:) Are YOSN8 o WAt L0 reCeive events mamorsed by unit

> Click the Yes button

ﬁ Walt . . .
1

Sancing programeming repuest

When the procedure has been completed, you will see a window showing the list of events recorded
by the Unit in the history of events.

00 = 0 )L 2000 D0 0030 -
GO

002 - 012112000 05:00:3%

Dirgitest error Externull Sean § 00030

003 = 0731 (2000 000019
Bl psend ey

0 - (T F000 D0 00153
A O

003 - 0 51 (2000 (00005
argded crrir Exterag Seen § {03

006 - 072112000 0 00:13

G n

007 - 04312000 00:00-05
Tamgd e prrr Dbl Deren D L))

000 - 000112000 (9:00:13
MO

(DD = 01 JE | A0 e M 05
T st ey Eatermal Sren Ll

_.“ti!-li:-lil:lsllu"_II:::‘:.IEIEI.J-{“" MR mnn e S — SIS <

> Click the Export button to export the event memory into a file



The following message will appear:

:_."f) P o) SUne om wank bo eport visuslised events 7

.

> Click the Yes button

The following screen will appear:

Ligai Lyenls

S [ L5 Expon ] D

My Rscent
Documanis

Dopriiog

il

Lo L

S come Fle i [* ]

> Name thefile

> Click the Save button
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7.3 Configuration of the Burglar alarm section

In this section it is possible to set up the part of the Unit related to the burglar alarm system.

The options are as follows:

* Zones

* Automations

e User Preferences

e Installer preferences

* Scenarios

= IBecurityPolyx - Burglar Alarm Switchb, Configurator

Fie Edt Took Langusge 7
[} mew & Cpen [ Swve Qbhm::-anul B Connaction Pt COMS =  Eealanguags = hhnlm_

B Myblorme ceniral unit
= i Burgler alarm
- [ 2one (12) Mytiome burglar alsrm switchh,
B common ubjects (2)
B connectors (2)
B zone 1 - zona 1(1)
B 2one?-rona  2(1)
B 2one 3 - zona ENEY]
Ezoned-zona 4 (3)
H Tore 5 - pona 5
B zore 6 - 2ona )]
BHaove?-20na 7(0)
B orw - 2ona Bm
B Ausiliary ()
B Automations (5)
ﬂ Lk praferances
= B irstalior prefarences

=2 Koy Management (3)
#) Scenarios (16)
= (2 Deallng devica
&3 telephone number directory
e Set calls (2)
= (R Telephons Functions
T Blodk (0)
P Profocol
Bl L st
T Telephone controks (00 i R
L1 ¥
A0 1700 Cantrse 3655

The tree structure will show the configured components with their number in brackets.
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7.3.1 Zones

This screen shows the list of zones in which the burglar alarm system is divided. For each zone it is
possible to enter a reference name which identifies it (eg. Entrance).

Entering the description of a zone is possible only after the configuration of at least one device
belonging to this zone.

Ia I SecurityPolyx - Burglar Alarm Switchb, Configurator
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.- B = mznﬂel-m 1
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& o i@ = Elmn-m 3
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= mlmhﬂnr preferences W E
=2 gey Management (3) H
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Bl Lirs st
T Tetephone controk (D) Tt v
' ¥
02008 1700 Certrae J6ID

The following paragraphs will describe how to set up devices in different zones; to perform these
configurations, the device must be present.

The present devices will be displayed in red.

vriagen | [l torvorrmcton m

B o Sevdl [ bt pu

- Dwvisn 1§ - peierics |
-
e (-

(e bl perdores 1
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Common objects

This screen displays the devices which are common to the whole unit.
It is possible to indicate the presence of the device and to enter a description.

Ia I SecurityPolyx - Burglar Alarm Switchb, Configurator

Fis Edt ook Langusge 7
0 v @ o o [B5Frio] s [ G| R - .
& MyHorme contral unit #7Beeove 7 Send [E] Evert memery
= ' Burglar alarm s
- [ 2one (12 5[] Pomer supply - perferica 2 -
vy
B connectors (2)
Eaone1-zona  1(1) Pover sugply W e Bty
B 2one 7 - 2ona 2(1)
E 20ne 3 - zona ENEY]
E zone 4 - zona 4(3)
Brwms5-ona 50 = ttemal swen 1 - perfenica 3
B w6 -zona 6 )
B Zore 7 - 703 7 Fregant o fes
B orw - 2ona Bm Doscriphicn porierica 3
B Auibary () Versicn 1.6
B Automations [5)
€ User praferances L
= 4B irstalieor preforences @ .
=2 gey Management (3)
#) Scenarios (16) - E
= M2 Deallng device @ E
&3 telephone number directory
% Sel calls (2) B ﬁ
= (R Telephons Functions = .Imundwml.-l-er#cﬂcilﬂ
Egrhjxf; Fracare < s
Elmlﬁt Descriphan perierica 10 a2
T Telephone controks (00 ey
L1 ¥
Connectors

This screen displays the connectors included in the burglar alarm system.
Itis possible to signal the presence, activate, enter a description and select the type of connectors

among the available ones.
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Zones 1...8

This screen displays the devices included in the single zones.
It is possible to signal the presence, activate, enter a description and select a type of device.

A IiBecurityPolyx - Burglar Alarm Swilchb, Configurator
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Furthermore, it is possible to enable/disable the activation delay the device can be delayed or
not depending on the type of device selected and on its firmware version.

] Ti%ecurityPolyx - Burglar Alarm Switchh, Configurator
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When you click the Information button, you will see a screen which will show how the delay time
will be set up for the devices of the zone.

Information on the devioes in £omel

Delay in entry

Value set to Usar

Delay in exit

preferences

Value set to User
preferances

0 sec.

Value set to User
preferances
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Auxiliaries

This screen displays the devices which are not included in the burglar alarm system (e.g. gas leak
detector).
It is possible to signal the presence, activate, enter a description and select a type of device.

Ia I SecurityPolyx - Burglar Alarm Switchb, Configurator
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7.3.2 Automations

This screen shows the list of automations that can be set up (Max. 20).
The automation lets you link an execution (set with an Open command) to one specific burglar alarm

event.
Itis possible to enable/disable the automation, enter a description and select an event to be matched

with an execution to produce the automation required.

Event Field

|"'| I BecurityPol Hurglar Alarm Switchb, Configurator
yx B £
Fie Edt Took Language T

[} bew @ Open [ Swve ;WII o} Wassagen |

ELW = »

£ Myblorme cariral unil = Bocovn ) Sered EE='|[ 7, meTery
= hf Burglar alarm -
a
. [ zone (12) = Autemation 1

B common objects (2)

B Connectors (1) .

-rad it ]
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Data input field
Event

Depending on the choice made, it is possible to select a type of event from the Type drop-down
menu; the underlying fields will be activated and dealt with later on.

Data input
Click Run to display the Open Configuration window. This can be used to define the Open Configu-
ration (manually or using the guided procedure) for the selected event.

Guided Insertion:

> Select the Open Command and select the data related to the system, to the action and to the
destination.

[Lightng | ausoeration | Scenaros | Tamperanse corrol | Burglar aterm | Ausdiary | Manust |
Tipsst of Dbyt BndEs s
[ saner =
] [Pownt-pors ;J
= = | jpontsa -

> Click the Ok button
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Manual Insertion:

> Type in the Open Web Net code to create the Open Command

Lightrg | autperation | Sosearns | Tamperanns ool | Burglar atarm | sy Manuai |

> Click the Ok button

Type of event - Alarm

> Select the type of event from the drop-down menu

Type of event - Technical

> Select the type of event from the drop-down menu

Type of event - Power lack

> Select the type of event from the drop-down menu

Type of event - Enable/Disable (Insertion/De-insertion)

> Select the type of event from the drop-down menu

The associated field will be activated by selecting the Scenario event

> Click the E] button to select the desired scenario

or



i
Y
|
|
|

| 5/

i

i E il

4]
.

:
Lk
3

carcdd | w |

Tras -

2] F Cotrmctor turder

. i o

FAETCRY @ iy e @ e ()

D Moh e o dnm
! / [ [

(] o

Tpm - et from wysben

P

Click the button to set the division

> Anindependent window will be opened, select the zones to be divided
No scenarios can be set if there are no active zones.
> Click Ok

The associated field will be activated by selecting the Connector event

> Type in the connector number

Type of event - Date

The associated field will be activated by selecting the Date event from the drop-down menu

> Clickthe E] button

> Enter the date and time for the activation of set automatic event in the Run field.
To set an automatic event to run every day at a certain time, enter %% in the Day/Month/Year
fields, and then the Hour and the Minutes.

> Click Ok

Type of event — Event from system

The associated field will be activated by selecting Event from system from the drop-down menu.

> Click the E] button

With this type of event it is possible to match two data inputs (open-open): the first through the
independent window which can be activated from the Event field whereas the second as per the
other type of event from the Run field.

> Anindependent window will be opened, enter the Open Command using the guided configu-
ration procedure, or by directly entering the instruction in the Manual section.

_l._l'_!"»llf'!:] |J|..mmar|m| Soerurns | Tamperaine corrol | Burglar atarm | Ausdiry | Manua |
Tyess of Dt ]
[ oo |
Comvand [ — :J
0N b ot .|
Firss Corcel | | Contim ]

> Click Ok
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Example of automation

- Lights ON in “Room 3" at every trespassing alarm.

ecurityPalyn - Burglar Alarm Switchh, Configuralor
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Procedure:
1 Enable automation
2 Type in the reference name of the automation (e.g. Staircase lights)
3 Select type of event - Alarm
4 Select Intrusion event
5 Enter the Open command which will activate the automation after the Intrusion event

Guided Configuration:

> Select System LIGHTING
> Select Action ON
> Select Destination ROOM 3

> Click the Ok button

Manual Insertion:

> Typein *1*1*3##

> Click the Ok button
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Example of automation

- Lower the blinds at 22:30 h every day.
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Procedure:

Enable automation
2 Typein the reference name of the automation (e.g. Evening)
3 Select type of event - Date

4 Enter the date and time

To set an automatic event to run every day at a certain time, enter %« in the Day/Month/Year

fields, and then the Hour and the Minutes.

> Click the Ok button

5 Enter the Open command which will activate the automation after the Date event

Guided Configuration:

> Select System AUTOMATISMS
> Select Action DOWN
> Select Destination GENERAL

> Click the Ok button

Manual Insertion:

> Typein *2*2*0##

> Click the Ok button
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Example of automation

- Lights OFF Room 4 when the blind is rolled up (e.g. light point 11).
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Procedure:
1 Enable automation
2 Type in the reference name of the automation (e.g. Day)
3 Select type of event - Event from system
4 Enter the Open command which will activate the automation.
Guided Configuration:
> Select System AUTOMATISMS
> Select Action UP
> Select Destination LIGHT POINT 11

> Click the Ok button

Manual Insertion:

> Typein *2*1*114#
> Click the Ok button

5 Enter the Open command which will be the automation.

Guided Configuration:

> Select System LIGHTING
> Select Action OFF
> Select Destination ROOM 4

> Click the Ok button

Manual Insertion:

> Typein *1*0*4##

> Click the Ok button
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User Code
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Enkry delay
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Display conkrast

7.3.3 User Preferences

This screen displays the user’s preferences.
It is possible to change all preferences in the procedures described hereinafter.
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It enables you to enter or change the user code of the Unit.

In the basic configuration the user and maintenance code are the same; they also enable you to
access all menus of the Unit.

Changing the user code will also automatically update the maintenance code as long as the latter
is not modified.

> Type in the user code in the required field

Sets the duration of the siren sound in case of an alarm due to tampering or problems related to
the SCS signal reception.

> Select one of the proposed values from the drop-down menu

Sets the duration of the siren sound in case of an alarm.
> Select one of the proposed values from the drop-down menu

Assigns the delay time for the activation of the sensors of zone 1. This allows you to pass through
zone 1 before disconnecting the system and without activating the alarm.

> Select the delay duration from the drop-down menu

Assigns the delay time for the activation of the sensors of zone 1. This allows you to pass through
zone 1 after enabling the system and without activating the alarm.

> Select the delay duration from the drop-down menu

Adjusts the display contrast of the Unit.
> Adjust the contrast with the arrows by clicking in the field
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Language

Maintenance Code

External siven flash

Tamphbest

Set time

Signaling

7.3.4 Installer Preferences

This screen displays the installer’s preferences.
It is possible to change all preferences in the procedures described hereinafter.
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Adjusts the display language of the Unit as well as the voice messages.
> Select one of the proposed languages from the drop-down menu

It enables you to enter or change the installer code (maintenance code).

In the basic configuration the user and maintenance code are the same; they also enable you to
access all menus of the Unit.

This function enables you to distinguish them in order to allow only the installer to access the
Maintenance menu of the Unit.

> Type in the maintenance code in the required field

Enables/disables the ON (3 flash) and OFF (1 flash) signaling (through the flash of the external siren)
of the burglar alarm system.

> Select Yes/No from the drop-down menu.

Enables/disables the periodic check of the interconnections between the Unit and devices con-
nected

> Select Activ./Deactiv. from the drop-down menu.

Sets the unit as a Master clock (sends the time update to all MyHome devices provided with a
clock, such as Touch Screen, Web Server, etc.) or as a Slave (receives the time update from other
devices).

Only one device of the MyHome system can be set as a Master.

> Select Master/Slave from the drop-down menu.

Activate/deactivate the audible signal at entry, exit, or both.
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7.3.5 Key management

The programmed keys on the Control Unit can be customized using this menu. The following fun-

ctions can be customized:
- key enable/disable
- ID name allocation

- combination with a scenario key or with a certain division

- limitation of the use of the key to certain weekdays and/or to a certain time band.

After programming the keys on the Control Unit, establish the PC connection and click “Receive’,

to transfer the configurations of the keys to the TiSecurityPolyx unit.
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Enables/disables the use of the key

Enter a name for the key, so that its use can be easily checked in the event memory

It indicates the type of key programmed on the Control Unit: IR remote control, keypad or

transponder
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Type of subdivision

Time limitation

It can be used to link one of the sixteen programmable division scenarios, or, in alternative, a specific
division, to the key (see following paragraph).

If the system is armed with the key programmed, the scenario or the division linked to the key will
become active.

W
Click to open the drop-down menu for the selection of the division scenario

) ===
[#] Tusschny e 2
[l wedrasday wanain 3
[ Thirsdey wmhan 4
[=] Friday senam §
[ sebwrday ey &
[ Surhar sEnan 7
Dt L soEnhann B
Ered tme wahaE 9
wenan 10
seanars 1 @

To setadivision not setas a scenario, select Division and click . A window will appear, showing

v

the zones present in the system. The ones showing the symbol are active. Click on the symbol
to deactivate them.

No scenarios can be set if there are no active zones.

Peviinn .
 fZone 1 r
¥ Tone 2 r
F zone 3 r
B Zona 4 I
Cacel | o

By default, the keys are enabled to be used at all times. It is however possible to limit their use
depending on the user needs.

In the example below, the use of the key has been limited to 8.30 to 11.30, Mondays and
Thursdays.

Time linwtation
[#] Hordday

O] Tuesday

[ wedresday

[ Thersdey

[ Fertary

[ saturday

[ sy

St time 0k:30

Ered time 13
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7.3.6 Scenarios

Up to sixteen division scenarios can be created in this section. These can be selected by the user,
depending on specific needs, using the Control Unit keypad.
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Enables/disables the scenario

Enter a name for the scenario (e.g. perimeter)

Select Division and click E A window will appear, showing the zones of the system, marked

with the IF

them.
No scenarios can be set if there are no active zones.

symbol. The symbol indicates that the zones are active, and can be clicked to activate

orrtion ———————_H|
= Zone F
¥ Zona 2 r
W Zonae 3 r
B Zona 4 ©
I
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7.4 Configuration of the Dialling device section

In this section it is possible to set up the part of the Unit related to the Telephone Dialling Device.

The options are as follows: :

* Telephone number directory
* Set calls
* Telephone functions

* Telephone controls
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The tree structure will show the configured components with their number in brackets.
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7.4.1 Telephone number directory

In this screen it is possible to set up the jolly number and the 10 telephone numbers of the di-
rectory.
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Jolly number

It is the first telephone number called by the Unit when any type of alarm is detected (intrusion,
failure, technical alarm).

If the MyHome portal is enabled, make sure the Jolly number matches the telephone number of
the portal.

If the ADEMCO protocol is used, the jolly number must be the surveillance unit number.

It is possible to enable/disable, enter a description and a telephone number.

Telephone number 1...10

It is possible to store the 10 telephone numbers of the directory in these fields. The numbers of
the directory entered will be able to be used (e.g. for being included in the 4 numbers to be called
according to the type of alarm recorded by the burglar alarm system - see “Outgoing calls”), only
if enabled in this template.

It is possible to enable/disable, enter a description and a telephone number.
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7.4.2 Setting up calls

This screen lets you match some telephone numbers stored in the directory with the alarm events
detectable by the burglar alarm or any specific Open event chosen by the user.

When a specific even occurs, the Control Unit will call the set phone number and communicate the
type of alarm that has occurred using a voice message (see chapter “Messages”).
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Calls following a System alarm event and System failure

> Enable/disable the event

> Select the telephone numbers of the directory to be matched with the event from the drop-down
menu (max. 4 numbers)

Calls following an Open event

Enable/disable the event
Type in the reference name
Enter the OPEN command which will initiate the call

vV V V V

Select the telephone numbers of the directory to be matched with the event from the drop-down
menu (max. 4 numbers)
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7.4.3 Telephone functions

This screen displays the telephone functions that can be customized.
It is possible to change all functions in the procedures described hereinafter.
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Enables/disables the dialling device to make telephone calls.
> Select Yes/No from the drop-down menu
If this function will be disabled and if a protocol (MyHome Portal or ADEMCO) is active, the following

message will appear:

2 O desslacting this option &l the protocels vl be deabled,
Y Contrus?

"

> Click the Yes button

The function is now “Enabled for outgoing calls” and the “MyHome Portal” service is disabled.

Sets the number of rings, after which the dialling device answers a call.If there’s an answering ma-
chine, the number of rings shall be higher than the one set for the answering system.

> Select the number of rings from the drop-down menu

Determines the number of times the dialling device will repeat calls to the numbers from which it
did not receive an answer.

> Select the number of cycles from the drop-down menu
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Call delay

DTMFfPULSE

Call wall For power ack.

Remoke management

AnSWENng prasencs

Enabling of sound diffusion

Wait between successive calls

Femote assstance

Sets the delay time, following an alarm, before the call cycle is started.
> Select the delay time from the drop-down menu

Allows you to set the type of line.
> Select DTMF (tone dialling line) or PULSE (pulse dialling line) from the drop-down menu

Sets the time between the moment power goes off and the starting time of the Unit telephone
calls.

> Select the waiting time from the drop-down menu

Enables/disables the management of the burglar alarm system from the telephone line.

> Select from the drop-down menu:
USER: Remote control can only be performed by the user.
MANAGER: Remote control can only be performed by the Surveillance Unit.
ON: Remote control can be performed by the User and by the Surveillance Unit.
OFF: Remote control is disabled.

Informs the dialling device that an answering machine is installed on the telephone line.
> Select Yes/No from the drop-down menu.

Enables/Disables the possibility to send remote voice messages to the room (via the Unit loud-
speaker and if connected from the sound system) and the room listening function via the Unit
microphone.

> Select Yes/No from the drop-down menu.

Assigns the waiting time between one call and the next.
> Select the waiting time from the drop-down menu

Enables/disables entry remote assistance calls for the surveillance units using the ADEMCO protocol.
Remote assistance is only possible if the 3485 control unit is in “System Test” mode.
> Select Yes/No from the drop-down menu
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7.4.4 Block (Lock)

In this screen it is possible, through the options available in the “Enabling” drop-down menu, to de-
cide not to lock the open commands remotely, to lock all of them or to set up to 4 Open commands
that cannot be performed remotely.
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> Select type of lock from the “Enabling” drop-down menu

If you select “Customized” it will be possible to define the filters described hereinafter.

SCENARICS (o {all) ("0 28]

> Enter a description for the filter

> Enter the Open command you
want to lock.
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7.4.5 Protocol - MyHome Portal

This screen displays the setups for managing the system through the MyHome portal.
> InType select MyHome Portal.

> Type in the password OPEN to access the system.

> Type in the System identifier provided by the MyHome portal
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After enabling the My Home Portal, if the Control unit is not “Enabled for out calls”, the fol-
lowing message will appear:

1 J Ta snable the portal servios sctivats B option "Ensblsd bo out gorg calls® in Talsphonic Functions

=]

> Execute the operations described in the message and repeat the operation

When the My Home Portal is enabled, the Jolly number must be the portal telephone number.

Erushiad ¥ e
hama Portal

Bamiber 02/ 12356789
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7.4.6 Protocol - ADEMCO

This setting enables automatic sending of alarm notifications and events to the surveillance unit

using the Contact ID protocol.

> InType select ADEMCO Service

> Enter the ADEMCO ID supplied by the surveillance unit

Please note: the ADEMCO
( ) protocol can only be acti-
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> Select the surveillance service level (refer to the table)
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7.4.7 Linetest

The Control unit can be set to check the good working order of the telephone line at set times and
intervals.

> Set the frequency for the completion of the test

> Enter the Test Start Hour and Minutes.
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7.4.8 Telephone commands

In this screen it is possible to set up telephone commands which can later be executed by the user
through simplified codes consisting of just 4 digits, through the Unit keypad or by telephone.

> Enable/disable the command
> Type in the reference name

> Enter the command open code.
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In this case, by remotely typing in the command 9911, the user will switch on the entrance lights
whereas if 9901 is typed in, they will switch off.

The user can record a personalized voice message only for the first 4 telephone commands (see
chapter “Messages”).
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8. Messages

In this section, it is possible to manage voice messages which are sent from the Unit to the set

telephone numbers when a particular event occurs or as an answer to telephone commands sent
by the user.

8.1 Work area
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The screensin the“Messages”section display the messages related to the type selected in the bottom
menu (fixed Messages, Presentation, customizable Calls, telephone Commands); it is possible to
select the various templates by clicking the corresponding buttons.

The screens are divided into two columns: the tree-structured Message column includes the mes-
sages whereas in the Content column it is possible to enter a name which identifies the message.
The messages will have a green background.

At the top part of the screen there is a message management bar and at the bottom there is a zone
where there will be different information related to the selected message.

Sends a message to Receives all messages Stops emitting/recording a
the Unit from the Unit message
@ Send - Listen 47 Receive ¥ Import way P Listen @ Record
Emits a message from the Imports an Emits a message Records a
Unit loudspeaker audio file message

Message (message length)

Speaker presence (2 sec.)
PRESS A NUMZER Example of the message voice contents
Message sent bo invite the speaker b ﬁ

Description of the message function
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8.2 Exchanging voice messages with the Unit

8.2.1 Sending voice messages

This function allows you to send one or more messages to the Unit.

> Execute the Connection to Unit procedure
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> Select by ticking the box next to the message to be sent

SecurityPolyx  Burglar Alarm Switchh. €

ik | Toos Langusge or select all messages
Irnpeaet messages from project
It configurston dats from progsdt . . . .
ot it i Bamci > Choose Select all messages from the Edit menu or

Select all fixed messages as needed

D) New G¥cpen [l Seve  Dpwyq > Click Send from the message management bar

wait until the procedure has been completed
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8.2.2 Listening to messages from the Unit loudspeaker
This function allows you to listen to the message selected from the Unit loudspeaker.

> Execute the Connection to Unit procedure.

> Select a message; the message will be highlighted.
Fa TiSecurityPaolyx - Burghar Alarm Switd
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> Click Listen from the message management bar
Messagn

The message will be emitted from the Unit loudspeaker.

8.2.3 Receiving voice messages

This function allows you to receive all messages included in the Unit.

> Execute the Connection to Unit procedure
Fa TiSecurityPolyx - Burghar Alarm Switd
Fi=  Edt
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> Click Receive from the message management bar.

The following message will appear

Please note: the messages in

the current project file will be
overwritten.

\;:j Arm you Sure ol wart 1o load the unit messsges 7

I bz I Mo

> Click the Yes button

When the procedure has been completed, the Unit voice messages will be available in the Messages
section for future verifications/changes, if required.
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8.3 Voice message commands

8.3.1 Importing an audio file

This function allows you to import an audio file.

> Select a message; the message will be highlighted.
> Click Import wav from the message management bar

The following screen will appear

Impart audio File

Losk i [0 Projects -

fe)

4y Flpomd
Caumanis

Peschsap

Nobwo, Fie ] =]

Fien o by [P st vl - Cancel

> Select the audio file (. wav) from where you want to import the messages

The installation directory includes the folder “Wave’, in which the voice messages are con-tained
and divided into folders according to the language.

The audio file must have the following features:

- maximum duration as per description (... sec.)

- type.wav

- sampling: PCM 8Khz

- resolution: 8 bit Mono

> Click the Open button

8.3.2 Emitting a voice message

This function allows you to emit a message from the PC loudspeaker

> Select a message; the message will be highlighted.
> Click Listen from the message management bar. the message will be emitted
> Click Stop from the message management bar to stop

8.3.3 Recording a voice message

This function allows you to record a message

> Select a message; the message will be highlighted.

> Click Record from the message management bar

> Start recording by speaking in a normal voice from a microphone connected to the PC
The recording will automatically end when the preset time for the message has elapsed.

8.3.4 Retrieving voice messages

This function allows you to retrieve voice messages set up for the Unit

> Select Load pre-defined audio messages from the Edit menu

The pre-defined audio messages will be retrieved by overwriting those of the current project.
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This function allows you to update the permanent basic software (firmware) in the unit through
revision procedures distributed by Bticino

9. Update Firmware

> Select Update Firmware from the Tools menu
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The Download Firmware screen will appear

Opens an Stops the update Exits the
update file procedure. screen

It is activated after

loading the file

Selects the serial port
of the PC to which the
Unit is connected

:
o
2
&

Exl Sanslpoi COMO =

Pl rone
1

Starts the update procedure.
Update file loaded
pdate e foade It is activated after loading the file

Displays a template contai-
ning information about the
Firmware

Displays log of activities
executed while
downloading

The above commands are also available in the File and Tools drop-down menu.

> Click the Select file button
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The following screen will appear

Select |irmmwade File
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> Select the update file (.fwz)
> Click the Open button

The Update button is now available

" Dewnload Firmesars
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> From the Port drop-down menu, select the serial port of the PC you want to connect the Unit to

> Click the Update button

The following message will appear

To updabe the device sxecube the Folowang operations:
1 - Switch unit bo maintenance

2 - Connect davice programming cable

3= Push Ok

{,.:.

(o ] bcuen|

Execute the required operations and then click OK
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Select the
maintenance

Slide switch
menu of the Unit
T LN =

ranguage
eI
System test
Learning

S I

B
)

Flip the slide switch to off

Click the OK button

Connect the programming cable to a serial port or a USB
of the PC and to the 6-way connector of the Unit.
Press the reset button.

Reset button

Vi

Item 3559
e
Item 335919

The application performs a comparison between the selected firmware and the Control Unit fir-
mware.

If the selected firmware is an older version than the one on the Control Unit, a warning will ap-
pear.

L s e procedurs continues, the deyvice will change from versson 6, 15 Lo yverson 6,11,
'-‘r) Contirue 7

Yes i o

click NO to terminate the update program

1) Distornect the programming cable from the device and press Ok

[T

> Disconnect the programming cable and press OK
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If the selected firmware is a more recent version than the one on the Control Unit, the update
procedure will continue without any other messages.

" Dewnlsad Firnmware ri
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When the update procedure has been completed, the following message will appear along with
an audible alert

Operation successfully completed

- Fuernorve programming cabbe from uni
- Push reset pushbutton on the raar of unit

> Disconnect the programming cable from the Unit
> Click the OK button

> Press the Unit reset button.

The Unit firmware is now updated.

Once the updating process has been completed it is possible, by clicking on Detail, to display a
window which lists the activities carried out during the firmware download operation.
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